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Lesson 2

Navigating the CATIA VS Environment

Introduction

In this lesson the user will not complete any one project but will be Figue 2.1

introduced to a lot of CATIA VS5 tools and concepts. These tools and . St
concepts are the ones that are required to successfully navigate around P
the CATIAVS environment. Gaining a firm understanding of these tools CATIA WSR17
and concepts will be critical for successfully completing all the other

lessons in this workbook.

Objectives

The main objective of this lesson is to present the necessary tools and concepts for the
user to successfully navigate the CATIA V5 environment. Some things in this lesson are
covered in general terms while others are covered in detail. The user is expected to learn
and understand each item as presented in the lesson. Tools and concepts that are briefly
introduced in this lesson lay the foundation for gaining deeper knowledge in later lessons.
Another purpose of the general introduction is to present the user with enough
information to promote self-discovery of CATIA V5. The following is a guide to what
the Review Questions and Practice Exercises will be testing for. You should know the
following:

- How to select any workbench.

- How to tell which CATIA V5 document is current/active.

- How the Specification Tree is linked to the geometry.

- How to modify the Specification Tree.

- What the compass is and how to use it.

- The five different methods of selecting entities.

- How to customize the Welcome to CATIA V5 window.

- How to modify the CATIA VS5 screens (maximize & minimize).

- How to modify the plane and axis representation.

- How to toggle the workbench toolbars on and off.

- How to tear away toolbars and relocate them on the screen.

- How to recognize when some workbench toolbars are hidden.

- How to recognize when additional tools are available in a toolbar.
- How to expand the toolbars with additional tools.

- How and where the view manipulation tools are.

- How to use the CATIA V5 Standard Toolbar and its tools.

- Where the Power Input Mode is and how to use it.

- Where and how to use CATIA V5’s Prompt Zone.

- The different areas of the CATIA V5 Screen.

- Gain a general understanding of what CATIA V5 tools are available.
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CATIA VS5 Standard Screen Layout

The following standard screen layout shows you where different tools and toolbars are
located. The numbers coordinate with the following pages where the tool label is bolded.
The tool label is followed by a brief explanation and in some cases, steps on how to use
and/or access the tool.

Figure 2.2
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The following list of menus is not meant to be a comprehensive definition of every tool
on the standard CATIA VS5 screen. The purpose is to provide a quick reference and
explanation. If more detailed information is needed and/or required, refer to the CATIA
V5 Help menu and/or internet homepage.
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@ The Start Menu

The Start pull down menu gives you access to all of the CATIA V5 Workbenches. The
availability of the workbenches will depend on the CATIA V5 licenses configuration, the
one shown in Figure 2.3 is the Educational Package (ED2) offered through the HEAT
Program. The workbenches used in this workbook will be found under Mechanical
Design, Shape, and Digital Mockup Workbench Categories. If you select the arrow to
the right of the Workbench Category the workbenches organized within that category will
be displayed, reference Figure 2.3. Figure 2.3 shows the workbenches organized under
the Mechanical Design Category. The Part Design Workbench is the highlighted
workbench.

The second section of the Start menu displays the active (open) CATIA V5 documents.
Figure 2.3 shows that Part] and Part2 are open and Part2 is the active document.

The third section of the Start menu is the most recent active CATIA V5 documents. This
allows you to quickly open recently active documents. For example, with the options
shown in Figure 2.3 the Analysis].CATAnalysis document could be opened by selecting
it from this menu rather than opening the browser window and browsing for it.

Figure 2.3
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@ The Current Active CATIA V5 Document

This area of the screen displays the name of the current active CATIA V5 document.
The active CATIA V5 document shown in Figure 2.2 is the default name
(Part1.CATPart) for a CATPart document. For a close up view with the document
circled reference Figure 2.4. Displaying the name of the current

document is quite typical of MS Windows compatible software. Figure 2.4

'%|CATIA ¥5 - [Part1] 33

@ The Standard Windows Toolbar

The Standard Windows toolbar contains your standard MS Windows pull down menus,
reference Figure 2.5. There are specific CATIA VS5 tools found in the different pull
down menus. The tools you
will be required to use in this
workbook will be defined in the

Figure 2.5
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options under the File pull down ] Hew.. el
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other MS Windows programs. (£ open... O
Close
Edit Menu —
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few options under the Edit pull SeREL i
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most other MS Windows Save Management. ..
programs. The first options are = 44 seorch.. -
also available on the Standard Bt P R
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Figure 2.2), such as the Undo Desk... E CrmEn
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Delete [Del]: This is one of _ _ _
Exit P} Scan or Define In Work Object,..

the numerous methods
CATIA V5 allows for you
to delete selected items.

Update [Ctrl+U]: The Update tool allows you to force the document to be updated.
There is a toggle in Tools>Options that allows CATIA V5 to update automatically.
When the Update tool is dimmed there is no update to be performed.
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Search [Crtl+F]: The Search tool allows you to search the document for almost any
type of variable. Selecting this tool brings up a Search window that allows you to
input specific parameters to help narrow the search.

Links: The Links tool allows you to view all documents that are linked to the current
document. This is a very useful tool when dealing with a multitude of linked
documents such as assemblies.

Properties [Alt+Enter]: The Properties tool allows you to view and/or modify the
properties of the selected element. This tool is also available contextually (selecting
the element and then selecting the right mouse button).

Scan or Define In Work Object: This tool allows you to review how the part in the
document was created, step-by-step. This is a powerful design and review tool that is

covered in depth in the Part Design Lesson.

View Menu

Most of the tools in this pull down menu have functions
dealing with the visualization of the CATIA V5
document. Many of the tools can be accessed from the
bottom toolbar, quick keys and contextually (right mouse
click). Figure 2.8 displays the tools available in the View
pull down menu. The following is a brief description of
each tool found in the View Pull Down Menu.

Toolbars: Toolbars allows you to toggle additional
toolbars on and off. If a particular tool gets closed
you can use this tool to turn it back on. This is

Figure 2.8
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Specification: This is a toggle tool that places the Specification Tree into hide/show.
Notice that there is also a quick key for this, F3.

Compass: This is a toggle tool that places the compass into hide/show. The compass
is area 5 in Figure 2.2.

Reset Compass: This tool allows you to reset the compass back to its original
location and orientation. For details, reference area 5 in Figure 2.2.

. . Figure 2.9
Tree Expansion: This tool allows you to expand the x
Specification Tree automatically, at specified levels, or Expand First Level
contract the Specification Tree. Selecting this option | Expand Second Level
will bring up a window similar to what is shown in B ol
Figure 2.9.

Collapse All

Specification Overview: This tool allows you to zoom .
X X R K Expand/Selection
in or out quickly on the Specification Tree.

Geometry Overview: This tool allows
you to zoom in or out quickly on the
geometry in the workspace. Selecting
this tool brings up the Overview on
geometry window as shown in Figure
2.10. Notice that the part showing in the
workspace is the same as what is shown
in the resizable window. As you change
the size and/or location of the resizable
window the geometry in the workspace
changes accordingly.

Figure 2.10

Fit All In: This tool allows you to
quickly zoom out so that all the geometry
is viewable on the screen. This tool is
also located on the bottom View Toolbar,
area 15 in Figure 2.2.

Resizable window

defining the

viewable geometry
Overview on geometry \ [Z]

>

Zoom Area: This tool allows you to
quickly zoom in on a particular area of
geometry. Select the tool and then using
the mouse select the first corner of a
rectangle that encompasses the area you want to zoom in on. Drag the cursor to the
second point of the rectangle and release the mouse button. The workspace window
will update to the area you just defined.

Zoom In Out: This tool allows you to quickly zoom out. This tool is also located on
the bottom View Toolbar. This is covered in detail in Lesson 4.
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Pan: This tool allows you to move the geometry around on the screen. It does not
change the location relative to the origin, just your view of the workspace. This tool
is also located on the bottom View Toolbar. This is covered in detail in Lesson 4.

Rotate: This tool allows you to rotate the part. This tool is also located on the
bottom View Toolbar. This is covered in detail in Lesson 4.
Modify: This tool provides some additional ways to Flgure 2.11
modify your views, some are duplicate methods, reference

Figure 2.11. Selecting the Modify option brings up a

window similar to the one shown in Figure 2.11. The first

four options will be covered in later lessons. Previous

View and Next View allow you to step back and forth

through the all the views still in memory. The Look At tool 1 Previous View
allows you to create a rectangle around the area you want to

look at, similar to the Zoom Area tool. The Turn Head I
tool allows you to pivot your view from the center of o Look At
rotation. This tool is hard to control and it is easy to loose rﬁ,«Iurn Head

sight of your geometry. If you experience this select the Fit Q =
All In. The Zoom In and Zoom Out tools are duplicates of N

the tools already discussed. The Normal View tool allows 2 Zeom Out
you to select a planar surface and CATIA V5 will rotate the % Normal View
selected planar surface normal (perpendicular) to your view.

Named Views: Selecting this tool
will bring up a window similar to the
one shown in Figure 2.12. All the Figure 2.12

T

default views are duplicates of views

provided in the View toolbar, area 15 il
in Figure 2.2. The real power of this = front ~] _wodfy_|
tool is the capability to create and save :E‘Ei'ék | = add I
your own custom view as shown in = right pekte_|
Figure 2.12. To create your own - =
custom view zoom and orient the o *iso 1 _Propertics |
geometry the way you want to save — hd

the view. Select View > Named My Custom View

Views, this will bring up the Named ‘@ ok | @apply| close |

Views Window. Select the Add

button. In the input window type the
name of your customized view. Select
the Apply button. Now any time you
want to jump to this view select View
> Named Views and select the view
you just created and named. CATIA
V5 will update to that view.
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Figure 2.13 Figure 2.14
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bring up a window similar to the one shown in Figure O ateral
2.13. The tools located in the first section of this O Triangles
window are duplicates of the tools found in the View O iafipaant
toolbar, reference area 15 in Figure 2.2. Selecting the [ Hidden edges and points
Customize View will bring up a window similar to the [ Dynamic hidden line removal
one shown in Figure 2.14. This particular tool allows b
you to mix and match different view properties. m
Review the options; apply them to some geometry so
you are comfortable with the different options. To @ cancel |

apply your customized view, select the OK button.

The geometry in the workspace can be represented using the Perspective view or the
Parallel view. The Perspective view shows the geometry as the human eye would
see it. The depth of the geometry reseeds back to a vanishing point. The Parallel
view shows the depth of the geometry true length.

Navigation Mode: Selecting the Navigation Mode will ~ Figure 2.15
bring up a menu similar to the one shown in Figure 2.15. ﬁ Examine
These options will be covered in detail in later lessons. ft\ —

Lighting: This tool allows you to modify the light 54 Hly
effect on the workspace. This tool will be covered in — ]
more detail in the DMU Workbench Lessons. CISESRE S SiEpi

Depth Effect: This tool allows you to modify and visualize the geometry at different
thicknesses. This tool will be covered in more detail in the DMU Workbench
Lessons.

Ground: This tool allows you to create and modify ground representation for the
geometry in the workspace. This tool will be covered in more detail in the DMU
Workbench Lessons.
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Magnifier: This tool allows you to zoom into a specific area of the geometry. This
tool will be covered in more detail in the DMU Workbench Lessons.

Hide/Show: This tool is a duplicate of the Hide/Show tool in the View toolbar,

reference area 15 in Figure 2.2.

Full Screen: This tool allows the workspace to take the entire area of the screen. All
the tools and toolbars disappear. This option provides significantly more work area
for your geometry. To bring back all the toolbars, make sure your cursor is over an

open section of the workspace and select the right mouse

button. This will bring up a window similar to the one Figure 2.16
shown in Figure 2.16. All you have to do is select the check
box and CATIA V5 will toggle the tools and toolbars back P Eull screen
onto the screen.
Insert Menu
Most of the Insert tools are alternative tools to the ones .
Figure 2.17

found in the workbench toolbars, such as Sketched-Based
Features and all the other options listed in the same
section of the pull down menu. The other tools are
alternative tools to ones found in the bottom toolbar such
as Axis System, Knowledge Templates and the other
options found in the last section of the pull down menu.

Body: This tool adds an additional Body onto the
Specification Tree. Compare Figure 2.25 with one
body and Figure 2.26 with two body branches. This
tool is covered in more detail in the Part Design and
Assembly Design Workbench Lessons.

Annotations: This tool allows you to create 3D
annotations (comments and/or notes). You can attach
the notes to a specific entity. The annotations can be
hidden and edited. You can make the annotation stay
normal to the screen, so you can read it as you rotate
the part. You can also link the annotation to a URL.
This is a helpful design review tool.

Constraints: This tool allows you to create 3D
constraints. If sketch-based constraints control the
actual profile the 3D constraint will show up as a
reference constraint (dimension). A reference
constraint has a set of brackets around it ().

I Tools  Window  Help
Dhject

%%Bndiin asSet...

@ Geomekrical Set...

g COrdered Geometrical Set...

% Inserk inneyy bodsy:

Annokations
Conskrainks

Sketcher

}. fxis Syskem. ..

Sketch-Based Features
Dress-lp Features
Surface-Based Features
Transformation Features
Boolean Cperations

Advanced Dress-Lp Features

Knowledge Templates

Eéé", Instantiate From Document. ..

@ Instantiate From Selection. ..
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Sketcher: This tool allows you to create a sketch. It is a duplicate of the Sketcher tool
found on the side toolbar. This tool is covered in more detail in the Sketcher
Workbench Lesson.

Axis System: This tool is a duplicate of the Axis System tool found in the Tools
Toolbar in the bottom toolbar. This tool is covered in more detail in the Surface
Workbench Lesson.

Sketch-Based Features: This toolbar is a duplicate of the Sketched-Based Features
found in the Part Design Workbench. This tool is covered in more detail in the
Sketch and Part Design Workbench Lessons.

Dress-Up Features: This toolbar is a duplicate of the toolbar found in the Part
Design Workbench. This tool is covered in more detail in the Part Design
Workbench Lessons.

Surface-Based Features: This toolbar is a duplicate of the toolbar found in the
Surfacing Workbenches. This tool is covered in more detail in the Wireframe and
Surface Design Workbench Lessons.

Transformation Features: This toolbar is a duplicate of the toolbar found in the
Part Design Workbench. This tool is covered in more detail in the Part Design
Workbench Lessons.

Boolean Operations: This toolbar does not by default Figure 2.18
show up on any workbenches used in this workbook. @ Assemble...
When a Boolean Operation between two partbodies is

required you can use this particular method of accessing (% Add...

the Boolean Operations. Another method is to customize (@ -
the Part Design Workbench so the Boolean Operation -

toolbar is included. This customization method is covered (@ B
in a later lesson. The tools in the Boolean Operation (% Urion Trim...

Toolbar are shown in Figure 2.18.

Knowledge Templates: This toolbar is a duplicate of the
Product Knowledge Template toolbar located in the
bottom toolbar, area 13 in Figure 2.2.

Instantiate from Document...: This toolbar is a duplicate of the Product
Knowledge Template toolbar located in the bottom toolbar, area 13 in Figure 2.2.

Instantiate from Selection...: This toolbar is a duplicate of the Product Knowledge
Template toolbar located in the bottom toolbar, area 13 in Figure 2.2.
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Tools Menu Figure 2.19
The Tools Menu contains some special tools not found el indow  Help
anywhere else in the CATIA V5 configuration. The $og Ecrmula. ..
Customize tool is one that you will want to get very Image y
familiar with. Note: The tools available in the Tools — N
Menu depend upon what Workbench is active. Jti"ty
Formula: This toolbar is a duplicate of the Show 4
Knowledge toolbar located in the bottom toolbar, e ’
area 18 in Figure 2.2. In Work Object v
. Parameterization Analysis. ..
Image' ThlS t(?OIbar allOWS Figure 2.20 Barents/Children, ..
you to capture images as well : i e
. E Cﬂjture Lelere Useless Elements. ..
as Vl.deOS. The toolbar also . B work on support 3
provides an image mqnagement i@l Album. . & Cotelog Brouser...
tool so you can organize your % _—
album. Reference Figure 2.20. |# " St
Visualization Filters. ..
. . opki
Macro: The tools in this pull down menu add =l
. o N Standards. ..
limitless possibilities for CATIA V5 users. You can a: = X
o . . Conferencing
create macros similar to most other MS Windows
software. You can also convert the macro to Visual 3 Publication. ..
Basic Language where you can start to modify and
customize the program. One of the more advanced .
capabilities is to integrate the customized program Figure 2.21
into your own tool. Macros... Alt+F3
Start Recording...
Utility...: This tool allows you to batch and
manage numerous types of processes. For an
example of the types of batch processes available Visual Basic Editor...  Alt+F11
reference Figure 2.22. '
Figure 2.22
| Batch Monitor g@
File  Edit Help
Start | Processes |
Type | Description
AnalysisUpdateBatch Analysis Batch
Batch-DXF-IGES-STEP Batch for Data Exchanges between CATIA and DXF, IGES(2D & 3D) or STEP
ExtractModelFromSequential Extract CATIA Version 4 Models from CATIA Version 4 sequential files
MigrateV4ToVs Migrate ¥4 files into V5 files
CATDMUBuilder Build CATProducts using given product structure documents and prepare cache
CATDMUUtlity Generate formats cgr, 3dmap, hog, wrl and NCGM from & CATIA file or MULTIC
CATDLIAVS Launich DUA on V5 documents
DatalifeCyde Data Life Cyde management
DownwardCompatibility Downward compatibility between the most recent release down to VSRE
UpdateBatch Drawing Update
PrintBatch Print Batch
< B
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Show: This tool seems very similar to the Hide/Show Figure 2.23
and Swap Visible Space tools located in the View
Toolbar at the bottom of the screen (area 15 in Figure | - anroms
2.2). The difference with this tool is that it allows you / HllLines
to show different types of entities. It is a filtering tool. ) All Curves

If you wanted to show just points you could filter
everything else out. Figure 2.23 displays the different
types of entities you can filter. The bottom section of
the toolbar allows you to customize the entity
selection.

Hide: This tool is very similar to the Show tool
except that it allows you to hide the selected entities.

In Work Object: This tool is a duplicate of the Scan
or Define In Work Object found in the Edit pull
down menu. Using the Player tools shown in Figure
2.24 you can step through the entire creation of the
part. This is a great tool for reviewing the design
process.

Figure 2.24
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all Elements
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Parameterization Analysis: This is another powerful document analysis tool. The

Hide tool allowed you to visualize different type of entities; this tool allows you to

Figure 2.25

list all the different type of entities. As the

designer you may know how many sketches
the document consists of but, as a manager

Parameterization Analysis

BE X

or design review member or someone that is
revising an existing design, you may not
know. This tool provides you a method of
easily and quickly obtaining that
information. The analyzed entities can be
much more complicated than a simple
sketch. Figure 2.25 displays the
Parameterization Analysis window with the
many different types of entities to select
from the pull down menu. Figure 2.25
shows that the Sketch entity is selected. The
open area of the window displays the
Sketches that were found in the example
CATPart document.

Filter  |all Sketches

ﬂ Refresh I

All Sketches

Over-constrained Sketches
Fully-constrained Sketches
Under-constrained Sketches
Inconsistent Sketches

External References

Inactivated Features

Root Features

Leaf Features

Isolated Features

Features in error

Waiting for update Features
Features with stop update
Features with active stop update
Knowledge Formulas, Rules and Checks
Bodies

A Geetcn,3
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Figure 2.26
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Parents/Children...: This tool is another powerful tool that can help you analyze a
part and find how all the features fit together. To use this tool you need to select a
branch of the Specification Tree. Otherwise the tool will be dimmed (un-selectable).
To get the results shown in Figure 2.26 the following steps were completed.

1. Select Sketchl from the example document.
2. Select Tools from the pull down menu.

3. Select the Parents/Children option. This will bring up the Parents and
Children window as shown in Figure 2.26. The window displays the selected
entity and all other entities that have either a parent or child relationship with
the selected entity (in this case Sketchl).

Customize: As stated by the name of the tool it allows you to customize CATIA V5
to user preferences. This tool allows you to customize the Start Menu, Workbenches,
Toolbars, Commands and additional Options. Area 7 of Figure 2.2 covers the Start
Menu in detail. Additional detail information will be presented in the following
lessons.

Options...: Ofall the tools covered in this pull down menu this one is the one that
cannot be avoided. The most basic of customization such as modifying Units to the
most advanced modifications are made using this toolbar. Some functions of this
toolbar have already been covered. Every lesson refers back to this tool to some
degree. The lessons will cover each individual function in more detail and apply it
directly to a particular problem and/or part.
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Standards...: Thistool  Figure 2.27
makes standardizing your —
) Standard Definiti 23
CATIA VS5 environment ek &
much easier than preViOUS Categor: |draf‘ﬁng jFiIe ¥ |.~'-\NSI.me ﬂ
releases. This tool is - - G e
particularly helpful when =" ANSI
defining your drafting -
standards. Figure 2.27 T" Styles
previews some of the -7 General
standard drafting options.
This tool will be covered =" AllowedToleranceFormats
in more detail in the =" AllowedNumericalFormats
Drafting Workbench
L =" AllowedTextFonts
essons.
=" AllowedTextFontSizes
ﬁ StandardUpdateMigration
i— DressUp
rﬁiﬁ‘ Dimension
=] ParentStandard
- =
- I—FQ e 'S i, JE POVS ) ii E ﬂ
1)) 2]
| @ cancal I
Conferencing: This tool allows Figure 2.28
you to connect to conference calls S5 B
via Net meeting all within CATIA
. Standards...
V5, reference Figure 2.28.
Conferencing Host
Guest

Publication: This tool allows you to publish partbodies entities. Figure 2.29 is an
example of Sketch.1 being published and exported. Notice that there is a new
Publication Branch added to Specification Tree. When Sketch.1 is selected Sketch.1
in the Publication Branch highlights also.
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Figure 2.29
i—EaLtaom S
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L o Hole.1 | Part1\PartBody\sketch. 1 is published with the name Sketch.1
d Publish a face, edge, axis, vertex or extremity
i—@ Sketch.2 g :
| & cancel l
gﬁ Publication -
L ) s
=
. Figure 2.30
Window —
This Pull Down Menu is similar to the typical MS . JEE tep i
Windows applications. The bottom section displays how L] tew Window
many documents are open; in Figure 2.30 there is only Tile Horizentally
one. The first section shows the different options for Tile Vertically
displaying the different documents (when there is more Cascade
than one).
) |7 1 Mavigating..Part
Help
This tool is also similar to most MS Windows Figure 2.31
applications. You can find out License and Release R 3
information as well as accessing CATIA V5 Compl.ete - =
Content, Index and search screen. You also have direct :
. CATIA User Companion
access to CATIA User Companion. One of the most
helpful tools is the What’s This? tool. All you have to Contents, Index and Search
do is select this tool and then the item you have a (12 whats This? Shift+F 1
question about and CATIA V5 will bring up an User Galaxy
information window about the selected item and a link
. . About CATIA VS
to the help files if one exists.
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@ The Specification Tree

The Specification Tree contains the history of tools Figure 2.32

and processes used to create a part. For example, you

can look at a completed part and see that there were Part1

fillets and holes applied to it. At what point in the part |
creation were the fillets and holes added? Are there &7 XY pare
redundant processes and extra elements? Can the &7 Yz plane
process for part creation be improved? Looking at the &7 7x plane
resulting part will not answer any of these questions. 1T: Axis Systems
The Specification Tree on the other hand has all of this

information. The Specification Tree contains the }' Absolute Axis System
entire history of the part creation. For a complex part, BartBody
the Specification Tree could get large.

Select the Tools, Options, General, Display, Tree Appearance or Tree Manipulation
option to specify what you want the Specification Tree to show and how you want it to
appear. The branches of the Specification Tree can be expanded and contracted by
selecting the — and + symbols located on each branch. You can Zoom In and Pan the
Specification Tree the same way you would a part. You must double click on a
Specification Tree branch to make the workspace go dim. Once the workspace is
dimmed (under intensified), all of the screen manipulation tools will apply to the
Specification Tree instead of the workspace. This means you can move and zoom the
Specification Tree as you do the part in the workspace. Double clicking a Specification
Tree branch will bring the part back to normal (the active workspace). The [F3| key will
hide the Specification Tree from view (a toggle key). CATIA V5 allows you to make
modifications to the part by using the part itself and/or by using the Specification Tree.
The Specification Tree is used in all the lessons. The Specification Tree is a very
powerful tool, but you must know how to use it to your advantage. The Specification
Tree shown in this section represents most of the branches and applications used in this
workbook. The presentation of the tree will vary depending on installation and
customization. The tree shown below was created with standard installation. The tree
was customized to show all branches such as Relationships, Formulas and Applications
using the Tools, Options window.
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Figure 2.33

Fartl
&7 Xy plane
&7 vz plane

ra

=5/ sketch 1
I*'ﬁ._g Absclutehxds
#-(n} Geomerry

|

#-7j] Constraints

&5 EdgeFilet. 1

="
Hole.z
@@ Sketch.4

L. Absoluteixis

Figure 2.32 displays a default Specification Tree. The Specification Tree has no
geometry added to it. Figure 2.33 displays all the geometrical elements that make up the
part shown in the workspace. Notice that the Hole.2 branch of the Specification Tree is
highlighted as well as Hole.2 in the part. CATIA V5 allows you to select the elements
using the Specification tree or the actual geometry in the workspace.

Figure 2.34

Options

e .
i Options : Tree Manipulation | Mavigation | i~ -
General Tree Tvpe
[ip- @ Classical Windows Skyle 2 Comstruckive Historic

OB compatibility O Structure 1 Relational

Tree Orientation

& o

z{*: Parameters and Measure

& Devices and Yirtual Reality
Tree Item Size

@ Text-dependent (! Fixed:

Infrastructure

Mechanical Design
Tree ShowiMoShow

Shape
F'-' p o Tree Show/NoShow mode

Analysis & Simulation

; i'-' HET Dt
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You can control how and what is displayed in the Specification Tree by completing the
following steps:

2.1
2.2
23

24
2.5

2.6
2.7

2.8
2.9

Select Tools > Options. This will bring up the Options window.

Expand the General branch and select Display.

Select the Tree Appearance tab. This will bring up the window similar to
the one shown in Figure 2.34.

Make sure your options match the options selected in Figure 2.34.

Select the Tree Manipulation tab. This will bring up the window similar to
the one shown in Figure 2.35.

Figure 2.35

Options

e .
i Options Tree Appearance Mavigation P,
General Scroll
[ii]- o Automatic scroll activation during DragDrop

Displ kry during Ml
%Cumpatibility [[] Display geometry during tree scroling
7 Parameters and Measure Aubomatic Expand
[] Automatic expand activation
" Devices and ¥irtual Reality

Zoaom on Tree
Infrastructure

o Tree zoom after clicking on any branch
Mechanical Design

Shape

FeT

Make sure your options match the options selected in Figure 2.35.

Select Parameters and Measure under the General branch in the Options
window.

Select the Knowledge tab.

Make sure your options match the options shown in Figure 2.36, particularly
the Parameter Tree View section.

Figure 2.36
Options
@ .
Tf Options Units Language Repor: Soi
"l General Pararmeter Tree Yiew
= i
[i'jj Display Bl o with value
o with Formula
B compatibilicy
P o
[:14 = 2
ra B [ surrounded by the symbal
" & Devices and Yirtual Reality
Relations update in part conkext
ﬂ'* Infrastructure E F .|:- )
Fi e Rl tm A Creation of synchronous reiaizz »

il
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2.10 Expand the Infrastructure branch of the Options Tree by selecting the + sign.

2.11 Select the Part Infrastructure branch of the tree.

2.12 Select the Display Tab.

2.13  Make sure all the options are selected under the Display In Specification
Tree section as shown in Figure 2.37.

Figure 2.37
=T .
i Opkions ierneral | Display | Park Document
== General Display In Specification Tree

External References

EI] Display

CH Compatibilty

|k

Parameters

ﬁ’-: Parameters and Measure

F?ﬁ Devices and Yirtual Reality

-
=

o Relations
4 Bodies under operations
-

-'. Infrastruckure Sketches
ﬁ pradlist S5 Ui Display In Geometry Area
— B t1aterial Library [ ] 2nly the current operated solid
— 4l Catalog Editor (] Only current body
_E Phato Studic [] eometry located after the current fe -

. . [] Parameters of Features and conste zios
—g Real Time Rendering

- & _ Axis syskem display size (in mm) r-ml A
— DELMIA Infrastrocture Checking Cperation ‘When Renaming

R N I Ll LR R

RN

The selections described in the previous steps are the options that control what kind of
information is displayed in the Specification Tree and how it is displayed. You are
encouraged to try the different options and develop your own preferences. As you go
through the lessons remember these options and revise them as required and/or needed.
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Figure 2.38

E‘@ < Productl created by entering the Assembly Design
Workbench.

ig Product2 (Product2.1) «————— Select Insert then Insert New Component.

— Product3 (Product3.1) «—————— Sclect Insert then New Product.

T Partl (Partl.1) < Select Insert then New Part.
réij Partl < Partl created by inserting New Part; double clicking will
take you to the Part Design Workbench.
— < xy plane
— <~ yz plane 4—————— Planes that define the axis.

— =7 zx plane
=@ .
T~ 2@ Relations
{f{:{] Formula.l: “width = =" d¢ «—— Formula that drives a Constraint in Relation

branch.
"” PartBody

@ Pad.l < The profile of Sketch.1 extruded (using the Pad tool).

*‘_w’i Sketch.l <€————— The sketched profile (sketched based features). Sketch.1
branch is expanded out in Figure 2.14.

| Alpine Fir <4—————— Material being applied to Part1.

=1
a_{i@ stp (stp.1) < Select Insert, Existing Component. This existing
component is a translated part using the Step (stp) translator.
#F— ¥ MASTER p P g p (stp)
= .
T 2B Relations < Relations branch contains Design Table.1.
*— % DesignTable.l < Design Table.1 is an external Excel Spread Sheet linked to
o Productl (the assembly).
=~ Applications Applications branch contains entities created in the DMU
I . . Navigator and Rendering Workbench such as Simulations,
T~ Simulation Lights, and Environments.
*“_ Turntable 1 < Turntablel is a particular type of Simulation. Simulation
allows you to move components within the assembly (animate).
T"_ Light <« Allows you to control the lighting on Productl (the assembly).
T Environment < Allows you to create a specific look for rendering Productl.
| The specific look is an environment.
L Replay < Replay allows you to play the created simulation using some

player controls. You can start the player by double clicking
on this branch of the Specification Tree. You must have a
simulation to play.
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@ Pad.l <
—

Pad.1 contains the extrusion information. To modify the Pad
thickness you would have to double click on this branch.

4 Slketch.] < Sketch.1 branch expanded out (from the previous page).

AbsoluteAxis<— Axis for the sketch.

Origin

=t* HDirection<— A sketch is only two-dimensional, so you have an H (Horizontal)

= VDirection

_/ Line.1
_/ Line.2
_/ Line.3
_/ Line .4

— ® Point.1
— * Point.2
— " Point.3

axis or direction and a V (Vertical) axis or direction.

L dk_l) Geomelry «——— Geometrical entities that define the sketch profile. These entities

can be modified in the Sketcher Workbench only (the workbench
they were created in).

i_ﬁl Constraints <—— Dimensional constraints applied to the sketch entities. Length.1

ﬁl Length.1
ﬁl Length.2

constraint drives the formula shown in the previous page.
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@ The Compass

This tool allows you to modify the location and ]
orientation of a part relative to the XYZ coordinates ~ Figure 2.39
and/or relative to other parts if they are in an
assembly. The application of this tool is described
in several of the lessons. You can place the cursor
over the center point of the axis and drag the
compass and drop it on a surface. Once the compass
is placed on a surface it will turn green. You can
then use the cursor to manipulate the orientation of
the part geometry by selecting the axis or direction
on the compass that you want the geometry
modified in. To restore the location and orientation
of the compass select View > Reset compass.

Select and
hold to rotate
geometry
about the Z
axis.

Select and hold to
move the compass
onto geometry.

@ The Select Tool and Toolbar

This tool allows you to select entities in the workspace and Figure 2.40
Specification Tree as well as the other areas of the CATIA V5 e D =
screen shown in Figure 2.2. The default selector is the Select
Arrow, which allows single point and left click selections. If J L B & o
you select the small arrow to the right of the icon, it will reveal
the other selection tools, they are shown below.

The Select Tool
Toolbar | Tool Name | Tool Definition
Ié Select This is the default tool. Point and click (left mouse button)
- to select the desired entity. Multiple entity selection can be
done by holding down the m key while selecting.
g | Selection This allows you to draw a box around the entities that you
Trap want to select. The box is exclusive to entities that intersect
with the selection box. This is a quick and easy multi-select
tool.
i3 Intersecting | This allows you to draw a box around the entities, but will
Trap also select the entities that are intersected with the box. The
selection box is inclusive.
Polygon This selection is similar to the box selection trap, but allows
* | Trap you to sketch a more defined area of inclusion and exclusion
of entities. This selection tool is quick, and allows you to be
more exclusive in the multi-selection process.
o Paint Stroke | This selection tool allows you to paint a line across the
Selection screen and any entity that the paint stroke crosses is
selected.
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@ The Current Workbench

The side bar will be filled with toolbars and tools associated with the
current workbench. As you select a different workbench you will
notice the toolbars and tools will change (reference area 10 in Figure
2.2). Figure 2.41 shows the Part Design Workbench. This is
especially critical when you have several windows open with
different workbenches. If you have them displayed on a split screen,
the active window will be the one with the blue border. You can

customize CATIA VS5 so that all
your favorite or most used
workbenches are available by
selecting the current workbench.
For example, Figure 2.41 is the
current workbench but you want to
switch to the Assembly design
Workbench. You can select the
current Part Design Workbench icon
as shown in Figure 2.41. Selecting
the tool will bring up a Welcome to
CATIA V5 window similar to what
is shown in Figure 2.42. The
workbenches that show up in the
Welcome to CATIA V5 Window
would be the ones you selected
when customizing this window. To
customize your Welcome to CATIA
V5 Window complete the following
Steps.

Figure 2.41
_18] x|
-2 x|

D)

Figure 2.42
Welcome to CATIA VS

B[]

B
<r.

Part Design Photo Studio

[ Do not show this dialog at startup

Real Time Rendering

Close I

2.7.1 From the Pull Down Menu (reference area 3 in Figure 2.2) select the Tools >
Customize option. This will bring up a window similar to the one shown in

Figure 2.43.

2.7.2  Select the Start Menu tab. Notice the list of workbenches listed in the left
column. They are listed as Available. With your mouse scroll down through the
list and find the Assembly Design Workbench. Select it so it is highlighted.

2.7.3  With the Assembly Design Workbench selected, select the arrow pointing to the
right === that is located between the columns. Selecting this arrow will place
the Assembly Design Workbench in the Favorites column. Every thing that is
placed in the Favorites column will show up in the Welcome to CATIA V5
Window every time the current workbench is selected.
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2.7.4 Continue browsing through the workbenches and select the workbenches that are
listed as favorites in Figure 2.43. Figures 2.42 and 2.43 show the workbenches
that will be used in following lessons.

Note: You can use the MS Windows function to multi select the workbenches. Hold the
Ctrl key down while selecting individual workbenches or hold the Shift key
down to select a continuous selection of workbenches.

2.7.5 You can also create quick keys; CATIAVS refers to them as Accelerators.
Highlight the workbench you want to create a quick key for and type in the keys
you want to be used for the quick key. Figure 2.43 shows that the quick key for
starting the Part Design Workbench is Ctrl+W. Creating quick keys is not
required for this lesson, but the option is there if you want to use it.

2.7.6  Once you have selected all the workbenches shown in figure 2.42 select the Close
key.

Figure 2.43
2.7.7 Now select the € . =~ |
Customize ? |
current .
workbench and Start Menu | User Workbenches | Toolbars | Commands Options |
verify the Available Favorites
Surface Meshi Sketch
workbenches 53;1;::5 R?:usthlizg - —_— Vu'irefr:rll-'ue and Surface Design
you selected Systems Space Reservation Assembly Desiagn
R Tolerancing Capture Catalog Editor
show up in the Tubing Design :" DMU Navigator
Tubing Diagrams Drafting
Welcome to Waveguide Design Part Desian
Waveguide Di h d
CATIA VS :ﬁ::rélegglsigenmagrams E\Euaﬁi?nt; F‘I\zndering
Window. Wireframe and Surface Design [ |
< 2]

2.7.8 Now you can Accelerator:| Crl-+w
Select any Of the Ctrl I Shift I Alt I Other... I
workbenches in ?Llse this page to make up a list of your favorite workbenches.

; Th kbench h the top of th i
the W1‘1'1d0W to Dr:;Ea;chl;:lruinwofibEJSdien;\I;Z;zeeﬁ Es ivailzhslﬁ:-sttgilglume Favorites list.
make it the
active Close I
workbench. -

Note: Under the Accelerator box there are keys you can select. This can be used to help
you if you don’t know the exact syntax. You can create the quick keys by
browsing through the different options.

Note: Using the Welcome to CATIA V5 window to select the Part Design workbench as

shown in Figure 2.43 is an alternative method to selecting the Start >
Mechanical Design > Part Design (reference area 1 Figure 2.2). Remember this
method allows you to select all the workbenches that are included in the license
package.
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Window Maximize and Minimize

These options are the same as most other MS Windows programs.
The top row of tools control CATIA V5 Program as a whole. The Flgure 2.44

a sign will minimize the program window. The m (last tool)
will close the program. The tools in the second row control the
active window within CATIA V5. If you have several CATIA V5 =
documents open you can minimize one or each of the windows &5
within the CATIA V5 program. You can resize & each of the
windows. The last tool * allows you to close an individual
window.

@ Plane Representation (Xy, yz and xz).

i i _ Figure 2.45

The intersecting planes represent the 0,0,0 point of the
workspace. Each plane is graphically represented in the Partl
wprkspace and also in the Specification Tree as shown in £ xy plane
Figure 2.45. If you select the YZ plane from the 2R
Specification Tree the YZ plane in the workspace will also =~
highlight, as shown in Figure 2.45. If you would rather have & zx plane
the 0,0,0 point be represented as an axis as shown in Figure PartBody
2.46 you can customize the workspace representation by
completing the following steps.
2.9.1 Select Tools > Options from the pull down Figure 2.46

menu (reference'area 2'1n Figure 2.2). This will 'EI" Partl

bring up the Options window.

w2y plane 2

2.9.2 Expand the Infrastructure branch of the Options s YZ plane )li

Tree by clicking on the + sign at the beginning o 7y plane s/ ~Y

of the branch.

t s Systems

2.9.3 Select the Part Infrastructure branch.

2.9.4 Select the Part Document tab. This will bring up the options shown in Figure
2.47.

2.9.5 Under the new part section select the box to “Create an Axis System When
Creating a New Part”.
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Figure 2.47

- LB Compatibility

-?&? Parameters and Measure

-':ﬁ' Devices and Virkual Realit:

at .

Options General | Display | Part: Docurnent |
7 B General When Creating Part

-H'l Display 4 iCreate an axis swsker

[] create a geometrical set
[] Create an ordered geometrical sek

[] Create a 50 work support:

4r.InFra5tructure o Display the “Mew Part”™ dialog box
-F‘ru:n:luu:t Skruckure Hybrid Design
- B Material Library o Enable hybrid design inside part bodies &2 -
-Catalng Edirar When created, locate wireframe and surface i
@ Inabody ) In a geometrical s
=B Pt Studio
nable hybrid design For parameters e a0
[] Enable hybrid design F k |
-&Real Time Rendering
- i Part Infrastructure

2.9.6 Select OK to complete the customization.

2.9.7 Create anew CATIA V5 Document. The new document will have an axis similar
to the one shown in Figure 2.46 in place of the three planes shown in Figure 2.45.

The Current Workbench Tools and Toolbars

This side bar will be filled with toolbars and tools
associated with the current workbench. If you select
a different workbench the tools and toolbars will
update to the newly selected workbench. Each
lesson covers a specific workbench. The tools and
toolbars specific to that workbench will be covered
in that particular lesson. The following is a list of
things you can do with the tools and toolbars.

Figure 2.48

Select this bar and\
drag the toolbar to
the new location.

\

Select this down
arrow to view the
additional tools as
shown in Figure

2.52 W,

» All the toolbars are tear away toolbars
meaning that you can select the top bar of
each tool as shown in figure 2.48 and drag it
to a new location.
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>

If you do not know the name of the tool you
can hold the cursor over the tool and the tool

name will be displayed as shown in Figure 2.49.

To close the toolbar you can select the red E at
the top of the toolbar.

To re-open the toolbar you can drag the cursor

over the side toolbar area and right mouse click.

This will bring up the contextual window
shown in Figure 2.50. Notice some tools are
selected and some are not. Each tool can be
toggled on or off just by selecting it. Figure
2.50 only represents a few of the 35+ toolbars.

Another method of re-opening

Figure 2.49

Hold the cursor
over the tool and
the tool name
will be displayed
as shown.

Figure 2.50

: Standard
arkbench

<]
= !

raphic Properties

7=

nowledge

Y

1=
i
=

30 Device

Swfnrkbenches

or adding a toolbar that does not
currently exist in a particular
workbench is to select View >
Toolbars. This brings up the
window as shown in Figure
2.51. From this window you
can toggle the tools on or off.

w” Geometry

" Specifications

w” Compass

Reset Compass

Commands List. ..

Window  Help

" Standard

Analyze

Graphic Propetties
|7 Knowledge

’7 Vigw

30 Device

F3

\Werkhenches

If there is a small arrow pointing down "= at the bottom right of a tool as indicated
in Figure 2.48 this indicates that there are additional tools available. To view the
additional tools select the down arrow. This will expand the toolbar as shown in
Figure 2.52. You can select the tool that you require. The selected tool will
become the default tool. The expanded toolbar can be torn away as its own stand-
alone toolbar by selecting the small bar and dragging it away. The result will be

similar to what is shown in Figure 2.53.

Figure 2.52 Select this small

bar and drag the
toolbar away.

Figure 2.53
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> You can create your own customized workbench with your favorite tools. To
complete this you would select Tools > Customize > Toolbars options.

» Sometimes there are too many tools and toolbars to display on the side bar at one
time. CATIA VS5 gives you an indication of this when you see the small double
chevrons at the bottom of the side bar as shown in Figure 2.54. To make all tools
visible select the small bar as shown in Figure 2.54 and drag it to an open area in
the workspace. If the double chevron symbols are still there that means you still
have additional toolbars. Continue the process until the symbol disappears.

Select this bar and drag it
into the open workspace
to visualize the additional

Figure 2.54 \L00Is.

«-—-KT he double chevron

. symbol indicates there
‘%ﬂm are additional tools
below this bottom bar.

@ Axis Orientation

This tool shows the orientation of the Axis within the workspace. The orientation will
change as you rotate the part or workspace around.

Figure 2.55 -
Axis et
Orientation y

7

CATIA
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@ The Tools Toolbar

00 % 5 £J

This toolbar changes depending on which workbench
you are in. The tools that are consistently in this
toolbar are listed below.

Toolbar

Tool Name

Tool Definition

)

Update All

This tool will be dimmed (under intensified) unless
there is an entity in the document that requires
updating. If the tool is colored (not under intensified) it
is signifying that some entity requires updating.
Selecting the tool will update all of the entities. This
tool is used most when revisions/changes are made to
existing constraints whether it is part design changes or
assembly changes. If you make a change and the
part/assembly does not reflect the change, check this
tool. It may require you to select it to force an update.

Axis System

This tool allows you to create multiple local axis
systems. The Surfacing Lesson gives detailed
instructions on how to create and orient new axis
systems.

10.1
10,0

Mean
Dimensions

This tool only works if you have previously defined a
tolerance to the entity. When tolerances have been
applied this tool will compute the actual (mean)
dimensions of the entity being reviewed.

*

Create Datum

This tool deactivates the history mode. The entities
used to create it will not be linked. The tool is a toggle
tool; if you select it you must unselect it to turn it off.

= Only Current | This tool gives you the option to display only the
= Operated current operated solid.

Solid
@ Open catalog | This tool allows access to the user-defined catalog.

Reference the Help menu for detailed instruction and
application.
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@ The Product Knowledge Template Toolbar

This toolbar allows you to create Power Copies and document the

- places the Power copies are instantiated.
=53
Toolbar | Tool Name | Tool Definition
% Power Copy | This tool allows you to create Power Copies. The
- Creation Power Copies can be applied to similar parts or parts
with similar features. The Power Copies can also be
saved to the Catalog.
B Instantiate This tool allows you apply a previously saved Power
i From Copy.
Document

The Analysis Toolbar

Analysis

[IEFESS =l|  This is another toolbar that is dependant on the active
| ] workbench.
w7
Toolbar | Tool Name Tool Definition
m Draft Analysis | This tool allows you to analyze draft angles and
distances. This tool is particularly helpful when the
angles and distances are too small to visually inspect.
m Curvature This tool allows you to analyze the curvature of a
i Analysis surface. This is particularly helpful when you have a
max and min curvature radius.
Ef;} Tap - Thread This tool provides the ability to analyze the current part

for thread and tap information.
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@ The View Toolbar

This toolbar contains CATIA

#| VS5 specific functions. This

| PN = = workbook will have you use
2 EEI Q* = Q Q L7 @ @- v' @ most of them in one lesson or

another. Most of the tools
apply to all of the workbenches.

Toolbar

Tool Name

Tool Definition

54,

Fly mode

Sets the fly mode. This is a very powerful and fun tool.
Reference lessons covering the DMU Workbenches on
how to use this tool.

&

Fit All In

This tool will show the extent of all the graphics
currently on the screen. It is a quick way to see what
elements are on the screen and where they are in
relationship to one another.

Pan

This tool allows you to move the part around on the
screen. The part does not change its location in the
XYZ coordinate system, only in relationship to the
screen. Every time you want to Pan the part you must
select this tool first, unless you have a three-button
mouse. Quick Key: With a three-button mouse you
can press the middle mouse button down and drag the
part to the desired location on the screen.

Rotate

This tool allows you to rotate the part in three-
dimensional space. It will place a representation of a
space ball (sphere) in the center of the screen. There is
a three-dimensional X on the space ball, you drag the X
to where you want on the space ball and the part will
rotate accordingly. This tool is critical to part
manipulation. It is important that you get the hang of
rotating the part to the orientation you want. This tool
must be selected every time you want to rotate the part.
This process is explained and shown step-by-step in
Lesson 4, Step 7. Quick Key: A quicker method is
using the mouse. Press the middle mouse button first,
while holding the middle button down, press the left
mouse button and drag the mouse around on the sphere.
This brings up the space ball (sphere). Another method
is to press the key while pressing the middle
mouse button and dragging the mouse around the
screen.
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Zoom In

This is similar to other graphics programs. This allows
you to get a closer look at finer detail. Quick Key:

Press the middle mouse button, hold it down as you press
the left mouse button and release it. Now use the mouse
to drag the cursor up the screen and the part will Zoom
In. Using the mouse to Zoom In is a much smoother
zooming method; you have more control.

Zoom Out

This is similar to other graphics programs. This allows
you to get the big picture, making the part smaller.
Quick Key: Press the middle mouse button, hold it
down as you press the left mouse button and release it.
Now drag the mouse down the screen and the part will
Zoom Out.

Normal View

This tool allows you to view a particular plane/surface in
a true length view. You specify the plane/surface and
CATIA VS5 will rotate the plane/surface 90 degrees to
your screen view. This will make the geometry on that
plane/surface true length. This is a very useful tool.

You could try to rotate a plane using the space ball so it
1s normal to your point of view, but you can only get it
close. This tool gets it exact. This tool can also be used
to flip the direction in which you view a sketch. Ifin
any of the lessons you go into the Sketcher Workbench
and your view is from the wrong direction use this tool
to flip your view 180 degrees. It will switch your point of
view from looking down on a part, to looking up from
the bottom.

@

Hide/Show

This tool allows you to select any entity or multiple
entities and place them in “no show space”. This
removes the selected entity/entities from the “working
space”. Sometimes there are entities that you want to
keep for future references but do not want them visually
in the way. You can pull the entities back into the
“working space” when you are ready for them.

Swap Visible
Space

This tool works hand in hand with the Hide/Show tool.
Selecting this tool will take you out of the “working
space” window and into the “no show space”. To pull an
element from the “no show space” you would select the
Swap Visible Space tool icon. This would show the “no
show space”. You could select the entity you want back
in the “working space”, and then select the Hide/Show
tool icon. This would take the entity back to the
“working space”. You would then need to select the
Swap Visible Space tool icon to get back to the
“working space”. This can be confusing; try bringing a
part back and forth until you get control of the two tools.
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Quick View Mode:

This tool icon has the arrow to the bottom right of

#| it, as explained in toolbar 5. The tool options are
all of the orthographic view options. NOTE: the

view projection is dependent on the plane the body

was created on.

@ Isometric Select this tool and CATIA V5 will rotate your part to an
View isometric view.

Front View Select this tool and CATIA V5 will rotate your part to a
front view.

Back View Select this tool and CATIA V5 will rotate your part to a
back view.

Left View Select this tool and CATIA V5 will rotate your part to a
left view.

Right View Select this tool and CATIA V5 will rotate your part to a
right view.

Top View Select this tool and CATIA V5 will rotate your part to a
top view.

Bottom View | Select this tool and CATIA V5 will rotate your part to a
bottom view.

View Mode:
|
'3 0@

=N NiNe

This tool icon has the arrow to the bottom right of it, as
explained in toolbar 5. There are six different options
associated with this tool; they are listed below.

3 Shading This tool shows the solid shaded without any edge line
(SHD) representation.
fil | Wireframe This shows the part as a wireframe, no solid, no shading.
(NHR) The (NHR) means “No Hidden Line Removal”. With no
hidden line removed, all edges of the part will be visible
at all times. This can be confusing at times; you could
lose track of which is the front side and which is the back
side of a part.
il Shading With | This tool allows you to control how your part is going to
Edges be represented, how it looks on the screen. This tool
shows the solid shaded and with the edge line
representation. The majority of the graphics in this
workbook are represented in this format.
[ | Shading With This tool shows the solid as shaded and the edge line
Edges And hidden.
Hidden Edges
&l Customize This tool will bring up a “Custom View Modes” window
View that gives you many different parameters to choose from.
Parameters If you apply material to your solid you will not see the
material represented unless you select the material option
in the “Custom View Modes” window.




2.34

CATIA VS5 Workbook

window.

| Shading With | Select this tool if you apply material to your solid but the
Material part is not shaded with the material and you have selected
the material option in the “Custom View Modes”

The CATIA V5 Standard Toolbar

p— This toolbar has nine tools in it.
Some offer an alternative method of

| [ 7 G w I %9 §3 [2 | accomplishing a similar task found in

the Standard MS Windows toolbar.
The tools are listed below with a brief
description.

Toolbar | Tool Name Tool Definition

D New Creates a new file (document).

G Open Opens an existing file (document).

= Save Saves the active file (document).

=k Quick Print Prints the active file (document).

&g Cut Deletes the selected element and/or elements. This tool
has the Windows NT functionality of select, drag and
drop.

Copy Another method of copying a selected element and/or
elements. The tool places the copied element and/or
elements onto the Windows NT clipboard.

! Paste Another method of pasting an element and/or elements
from the Windows NT clipboard.

L)) Undo The greatest OOPS tool developed since the invention
of the computer! This tool allows you to step
backwards one mistake (function) at a time!

Redo Make that a double OOPS! This tool allows you to
—— undo your undo! If your last operations weren’t so bad
and you don’t remember all of the parameters you
entered, this tool is for you.

2 What’s This? Direct link to the help file. Select the item you have a
question about then select this tool. CATIAVS will
search the help files for information on the selected
item.
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@ The Prompt Zone Figure 2.56
The Prompt Zone (bottom left of the screen) prompts the ) &3 @

user for the information and/or input required to
complete the process. A good rule of thumb, when in

doubt read the Prompt!

S@a plane, a planar face or a sketch

Prompts the user for the
information required to

&)mplete the process.

The Knowledge Toolbar

Knowledge

foo &

@ B3

This toolbar allows you to use formulas and spread
sheets to parameterize your sketches, parts and
assemblies.

X

Toolbar

Tool Name

Tool Definition

feo

Formula

This tool allows you to use a formula to drive
parameters.

Comment &

This tool provides access to the Comment and URLSs

URLSs editor.
A Check Analysis | This tool allows the user to define design standards and
Toolbox check parts against the standards.

Design Table

This tool allows you to use data from an existing spread
sheet to drive assigned parameters within a design

F':'El Law This tool allows you to access the law editor.

i Knowledge This tool allows you to preview a design change prior
S Inspector to committing to the change. This is an advanced tool.
@ Lock Selected | This tool allows the user to lock selected parameters.

- Parameters
) | Unlock This tool allows the user to unlock selected parameters.
Selected
Parameters
%}: Equivalent This tool allows the user to make two parameters equal
e Dimensions to each other. This tool applies to most dimensional
Head (length) type parameters.
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The Apply Material Tool Figure 2.57
%

This tool allows you to apply a material to your solid. Applying a =

material will give it the properties of the material such as the density so

CATIA V5 can calculate weight, volume and other part analysis information. Applying

material also gives the solid the texture and color of the selected material. CATIA V5

has a library of material. The use of this tool is covered in the Part Design Lesson.

Remember, to see the material applied to the solid you must select Apply Material in the

Customize View Parameters.

CATIA VS5 allows you to create your own material using the Material Library
Workbench found in the Infrastructure Workbench category.

The Measure Tool

Measure_ | There are three analysis type tools; they are listed below.

2 a g

Toolbar | Tool Name | Tool Definition

> Measure This tool allows you to measure the distance between

= Between two different entities. You can measure the distance
between surfaces, planes, lines, points etc. Select the
Measure Between tool and then the two entities. This
will bring up the Measure Between window. This
window has more information than most designers
would want. In most cases, the dimension created
between the two selected entities is enough information.
a Measure Item | This tool is very similar to the Measure Between tool

except that it measures the length of an individual
entity. Select the Measure Item tool and then select
the item to be measured. This will bring up the
Measure Item window. In most cases, the dimension
created on the selected entity is all that is needed.
ﬁ Measure This measures the physical attributes of the selected
Inertia solid such as volume, mass, centroid, etc.
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@ The Power Input Mode

This input window is for more advanced uses. You will notice as you select a tool, the
tool command will appear in this window. In advanced uses, this window can be used
similarly to quick keys and scripting. For detailed information reference the Help menu.
This tool is not used in this workbook.

Figure 2.58

F i Ra 22

| =

@ The Double Chevron Symbols

When the workbench toolbars show these arrows at the bottom or end of the toolbar, it
signifies there are additional tools belonging to that particular workbench. CATIA V5
gives you an indication of this when you see the small double chevrons at the bottom of
the side bar as shown in Figure 2.59. To make all tools and toolbars visible select the
small bar as shown in Figure 2.59 and drag it to an open area in the workspace. Ifthe
double chevron symbols are still there that means you still have additional toolbars.
Continue the process until the double chevron symbol disappears.

Figure 2.59

Select this bar and drag it
into the open workspace

to visualize the additional
tools.

The double chevron
symbol indicates there
are additional tools

below this bottom bar.

Summary

As stated in the Introduction there is not a lot of action required in this lesson but that
does not dismiss its importance. The better these tools and concepts are remembered the
more successful the user will be in attempting the remaining lessons. Remember all the
other lessons are built around the knowledge presented in this lesson.
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Review Questions

After completing this lesson you should be able to answer the questions and explain the

concepts listed below. s o :

1. What does the double chevron at the bottom of the side

toolbar indicate? &
Y 7

2. TorF The Apply Material Tool =8 applies the i
material properties to the specific solid so the weight of the
solid can be computed.

3. What is the difference between the Measure Between 1 Tool and
Measure Item ‘:ﬂ Tool?

4. TorF You can select the XY Plane from the graphics window or the
Specification Tree.

5. TorF You can customize the workbenches that are displayed in the
Welcome to CATIA V5 window (this window is brought up by selecting the
current workbench tool).

6. List three of the five Selection tools l} .

7. Where is the Prompt Zone located within the CATIA V5 Screen?

8. What is the purpose of the Prompt Zone?

9. TorF The Standard Toolbar has many of the same tools found in the File
and Edit menus from the top pull down menus.

10. List all the views that are available in the Quick View toolbar.

11. What is the purpose of the Specification Tree?

12. What is the purpose of the Compass?

13. Where does CATIA VS5 display the current active workbench?

14. Where does CATIA V5 display the current active document/file?

15. What tool would you use to bring all the entities in a document into view on

the screen?
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16.

17.

18.

19.

20.

Where is the Shading with Edges tool found?

List the steps required to make the Part Design Workbench the current
workbench.

T or F Each individual line in a sketch has it’s own individual branch in the
Specification Tree.

A
T or F The Normal View Tool 7 | rotates the selected planar surface
normal to the screen so it can be viewed true size and shape.

T or F The Rotate tool = allows the user to rotate the part (graphics
window) in a true 3D rotation.
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Practice Exercises

After completing this lesson you should be able to complete the following exercises.

1.

2.

Memorize all 22 labeled areas of the CATIA V5 Screen.
Review the top pull down menu tools.

Review the Specification Tree.

Review the bottom toolbar and all its tools.

Make the Part Design Workbench the current workbench.

Extra Credit: Customize the Welcome CATIA V5 window to show the
workbenches shown in Figure 2.42.





